User Manual

VWP24-18G / VWP29-18G

Dual input HDMI 2.0
18G VIDEO WALL PROCESSORS

SY Electronics Ltd., 7 Worrall Street, Salford, Greater Manchester, M5 4TH, UK
Tel: +44 (0)161 868 3450 — Web: sy.uk



Contents

FEATURES 4
CONNECTORS AND CONTROLS 4
Front 4
Rear 5
USING THE VWP24 AND VYWP29 5
VWP24 AND VWP29 PC TOOL 5
EDID management 6
Signal Setting tab on the PC tool 7
PQ tab on the PC tool 7
CEC tab on the PC tool 7
Video Wall tab on the PC tool 8
Bezel Setting 9

Bezel Compensation 9
Video Wall Context Menu 10
Layout Save/Load 10
DAISY CHAIN AND CASCADE MODE 11
LAN AND RS232 CONTROL COMMANDS 12
Video Selections 13
Preset Save and Recall 13
Test Pattern 13
SPECIFICATIONS 15
General 15
Video and Audio 15
Power Supply 15
Environmental and Physical 15
Package Contents 16
Safety Instructions 16
After Sales Service 16

sy.uk 2 V1.0


http://www.sy.co.uk/

Thank you for purchasing the Video-Wall Processor.

This Video-Wall processor is designed with the professional AV installers in mind. The many
extensive features assist in system integration, validation and maintenance. Please carefully
read this manual prior to installation and keep for future reference. You can download further
supporting documentations from our web site (sy.co.uk)

Installation precautions

This product has special circuitry to protect it against moderate surges and static discharges.
However, to ensure reliable operation and long service life, it is important to take the
necessary precautions against any spikes, surges, lightening and static discharges.

Place the unit away from heat sources and allow adequate ventilation.

High quality High-Speed HDMI 2.0 cables (such as SY Stealth range) are highly recommended.
As much as possible cables should be routed away from any noisy sources and avoiding long
runs in close proximity to mains cables.
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VWP24/VWP29 are HDMI 2.0 Video Wall controllers with 2 HDMI inputs, 2 HDMI loop outs and
4/9 HDMI scaling outputs respectively for video wall processing. The de-embedded audio is
available as S/PDIF (optical Mini-Toslink) / analogue L/R audio, as well as a balanced L+R
analogue audio outputs.

VWP24/VW29 support an RS232 pass through feature to allow the connection of several units a
daisy chain or cascade configuration.

Features
e  Supports all resolutions up to HDMI 2.0 (4K60 4:4:) and HDCP2.2
e  2xHDMI 2.0 inputs and 2x HDMI loop outs
e  Full scaler per output: Scale Up/Down to any resolutions up to 4K60 4:4:4 (18G)
e Daisy chain or Cascade connections for large Video Walls (up to 8x8)
e  Supports display splicing and 180° image rotation
e  Audio de-embed — Balanced L+R, L/R, Optical Mini-Toslink
e  RS232 and TCP/IP control
e Support CEC control to the display by SY-PCTools or RS232 commands

Connectors and Controls

Front
VWP-24-18G  1owz0160 vssowat rassssr sy
g ;' “5: e '

VWP-29-18G  voui2.0 185 ides wait Procssscr g
Name Description ‘
PWR-LED Lit when the unit is powered
HD A-LED Active HDMI A input
HD B-LED Active HDMI B input
LP A-LED Lit when Loop out A is connected
LP B-LED Lit when Loop out B is connected
HD 1...9-LED Lit when the corresponding HDMI out is connected
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Name Description

LAN RJ45 control port for operation by TCP/IP
External RS232 control, Baud Rate: 57600

RS232-CTL Data Bits: 8 Parity: None Stop Bits: 1
RS232 To bypass RS232-CTL commands to next unit
UPDATE Firmware upgrade
Balanced Audio out 5 way phoenix Jacket, 20Hz — 20kHz, 1.5Vrms max
e L+R Audio Output
Mini Toslink 3.5mm Stereo Jack. 20Hz — 20kHz, 1.5Vrms max
e Optical S/PDIF Audio Output
HD A HDMI A input
HD B HDMI B input
LOOP OUT A Bypass HDMI A signal to downstream

Bypass HD B or HD A signal to downstream — configured by RS232 /

LOOP OUT B/MAIN LAN command

HD 1..HD 4 . . .

HD 1..HD 9 HDMI scaling outputs for video wall display
DC2.1 VWP-24-18G: 12V/3A DC power input

IEC C14 VWP-29-18G: 110-240V Mains input — 2A Fuse

Using the VWP24 and VWP29

Connect the desired video sources to VWP24 or VWP29 input HD A or HD B connectors and the
desired output video wall display devices to HD1...HD9 HDMI output connector. VWP24/VWP29
units can be cascaded together (or Daisy chained) to create any size video wall (8x8 max).

The PC Tool facilitates easy set up and operation. The units can be controlled via LAN or RS232
connection. Up to 10 VW layout configurations can be saved and recalled as required.

VWP24 and VWP29 PC tool
Switch tab on the PC tool

1. PC tool connection with UART or Network

2. Select input source for each scaling output port

3. All Set function, select HD A or B to all the scaling output

4. Select input source for B/MAIN output port

5. Select audio source for balanced audio output and Mini Toslink output
6. EDID configure
7. Reset
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Suitch | signal Setting | PQ&Position | video Wall

INPUT

OUTPUTS S inie] @ioin

LOOP OUT ~

HDMI 1 &1 B/MAIN 1 81

HDMI 2 ®2
HDMI 3
HDMI 4
HDMI 5
HDMI 6
HDMI 7

HDMI 8

HDMI 9

EDID

Port [ee]VERNEY

1P Address

Device Name MAC Address

Find via UART

EDID management

The display EDID can be read from each
HDMI output and saved as a binary
(*.bin) file.

An existing EDID file can be opened and
written to either the HDMI A or the
HDMI B input port as Manual EDID for
that input.

The user can select from a pre-defined
EDID setting and set the HDMI A and B
input ports to that setting.

The Manual EDID option is normally
used only after an EDID binary image
has been written to that location.

The Predefine EDID options are as
follows:

e 4K60-2.0CH (default)

e  4K60-5.1CH
e  4K30-2.0CH
e 4K30-5.1CH

e 1080P60 -2.0CH

e 1080P60-5.1CH

e  720P60-2.0CH

e  1024x768P -2.0CH

sy.uk

INPUT
AUDIO OQUTPUT

S HD B

Version

sY EDID

INPUT
SHDA ®HDB

=

5 | S|

1

EDID Read Port (Output)

EDID Configure (Devicce ID)

@1
EDID Mode
a7 4KB0-2.0CH s
L ake0-5.1CH /
4K30-2.0CH
2@ @1 e2 @3 MIDSDP-Z.DCH @B eC eD et eF
e |  1080P-5.1CH
1o 720P-2.0CH
22 1024x768-2.0CH
i 1920%1200-2.0CH
= 1680x1050-2.0CH
58 1600x1200-2.0CH
78 1440x900-2.0CH
z8 1400x1050-2.0CH
a8 1360x768-2.0CH
22 1280x1024-2.0CH
e MANUAL
De
E@e
Fe
° 1920x1200 -2.0CH
. 1680x1050 -2.0CH
. 1600x1200 -2.0CH
. 1440x900 -2.0CH
. 1400x1050 -2.0CH
. 1360x768 -2.0CH
. 1280x1024 -2.0CH
. MANUAL
6
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Signal Setting tab on the PC tool

This tab allows the user to read each input port resolution and set each output scaling setting.

Switch Signal Setting | PQ&Position | Video Wall|

—Input Board—|Read Al

Label InputType  Input Format

A [HoMmI 3840x2160
B [HDMI Read

Qutput anrd—@]
Label Output Type Qutput Format

1 [UHD-HDMI ~| [38a0x2160@6¢ ~]
[uHD-HDMI ~| [38a0x2160@6¢ ~]
[UHD-HDMI ~ ] [38a0x2160@6¢ ~
[UHD-HDMI ~ | [38a0x2160@6¢ ~]
[UHD-HDMI ~ | [38a0x2160@6¢ ~]

[UHD-HDMI ~] [38a0x2160@6¢ ~] [R
[uHD-HDMI ~| [3840x2160@6¢ ~| [R

[ R s N ¥

[uD-HoM ~| [3840x2160@6¢ ~|
[uD-HoM ~| [3840x2160@6¢ ~|

Available output resolutions:

Number  Output Resolution Setting Number  Output Resolution Setting
1 3840x2160p 60Hz 9 1440x1050 60Hz
2 3840x2160p 50Hz 10 1366x768 60Hz
3 3840x2160p 30Hz 11 1360x768 60Hz
4 3840x2160p 25Hz 12 1280x1024 60Hz
5 1920x1200 60Hz 13 1280x768 60Hz
6 1920x1080p 60Hz 14 1280x720p 60Hz
7 1920x1080p 50Hz 15 1280x720p 50Hz
8 1600x1200 60Hz 16 1024x768 60Hz

Please Note: 3840x2160 25/30Hz can only be used for stand-alone display, not for video wall.

PQ tab on the PC tool

Each output port settings can be
fine-tuned if required.

It is strongly recommended that
these values always use the
default setting of 50/50/50/50, as
it may be difficult to achieve
colour matching between all the
outputs.

CEC tab on the PC tool

This tab provides CEC control of
the display / sound-bar settings.

V1.0

Switch | Signal Setting PQ&Position |Video Wall |

Select PQ FineTune Po

Brightness - 5

Contrast g

Saturation ' g

Sharpness %

[Auto Power ONJ
Output

Output1 | Power ON | [ Power OFF | [ volume+ | [ volume- | [Mute/Unmute]
Output2 | Power ON | [ Power OFF | [ Volume+ | [ volume- | [Mute/Unmute]
Output3 | Power ON | [ Power OFF | [ Volume+ | [ Volume- | [Mute/Unmute]
Output4 | Power ON | [ Power OFF | [ Volume+ | [ volume- | [Mute/Unmute]
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Video Wall tab on the PC tool

The Video Wall tab is used to configure a group of outputs to function as a video wall.

SY

Switchl Signal Seﬂing} PQ&Position Video Wall l

——  VideoWall Setting ~ —— Video Wall

Rows 3 &

Columns 3 — Screen 1 Screen 2 Screen 3
Available 9 £ J

[ Set ][ Read ]

Bezel Setting Screen 4 Screen 5 Screen b

Type: @A @B

Left(Pixels) ]

Right(Pixels) |:|

Top(Pixels) l:l Screen 7 Screen 8 Screen 9
Bottom(Pixels) |:|

Layout Save/Load —

[ Save Layout ][ Load Layout ]

1.

Use the Video Wall Setting controls to change how the displays are arranged on the

Video Wall tab:

a. Adjust the Rows and Columns sliders to change the displayed screen arrangement to
permit proper Drag-and-Select of the desired screens for the video wall.

b. Change the Available slider to set how many outputs will be used for the Video Wall.

c. Click the Set button to change the Screen configuration on the Video Wall tab.

Use the left mouse button to drag-select the screens that will be set for video wall mode.
The selected screens will be shown as bright blue.

Use the right mouse button to open a menu.

Select Screen Stitching from the menu to program the video wall mode. The selected
screens will now be shown as bright green.

To change the displayed image: right-click on the respective Screen window to open the
pop-up menu and select the desired input from the Input Select menu option.

Repeating steps 2 to 5 above with a different set of outputs allows the creation of a second video
wall. However, changing the Rows, Columns and Available sliders will automatically delete the
current video wall set up when the Set button is clicked.

The following example shows a more unusual video wall set-up of two video walls with 1x3 and
2x2 configurations:

sy.uk
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Switchl Signal Seﬂingl PQ&Position Video Wall |

— VideoWall Setting — Video Wall

Rows 3 L U

Columns 3 0

Available 9 L ]
Set ” Read I

Screen 6

Bezel Setting
Type: @A (OB

Left(Pixels) P
Right(Pixels) CI
Top(Pixels) l:l Screen 9
Bottom(Pixels) D

— Layout Save/Load —

I Save Layout ” Load Layout I

Screens 6 and 9 can be used as single screen displays, as they are not part of the video wall set.

Bezel Setting

The Bezel Setting section allows the entry of values to compensate for the display bezel thickness.
These values may be entered either as pixels (Type A) or as millimetres (Type B).

Type A Bezel Settings

The image size will be adjusted to allow for the number of pixels entered in each of the entry
boxes. Click the Set button view the effect of the new values.

Type B Bezel Settings

The image size will be adjusted to allow for the Inner and Outer display dimensions as entered
in each of the entry boxes. Click the Set button view the effect of the new values.

Bezel Compensation
The following images demonstrate the effect of not having bezel compensation and what a
correctly configured bezel compensation settings should produce:

No Bezel Compensation Correct Bezel Compensation
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Video Wall Context Menu
Right clicking on any of the screen icons will
display the following context menu:

Screen Splicing
Cancel Splicing
Screen 2 - Cancel Splicing

Input Select »
Output Select ’
Output Type »
Output Format >
Rotate »
Test Pattern ’

Screen Stitching

This option stitches and connects the selected screens into a video wall
configuration.

Cancel Stitching

Return the Video Wall configuration to normal individual outputs.

Screen x — Cancel Stitching

Removes a single screen
x from the video wall,
which allows it to display
another image within the
video wall configuration,

as shown in this example:

Video Wall display with bezel compensation and
different full frame image on display 3

Input Select

Use the sub-menu to select the input to display on the video wall or the
secondary input image shown in the above example.

Output Select

This option is only available for any screen that is not assigned to a video
wall mode.

Output Type

Use the submenu to set the HDCP options for that output.

Rotate

Two sub options: OFF (default — No rotation), ON (Rotate image).
Select ON: 180° image rotation of the selected screen

Test Pattern

Each output can display Colour Bar pattern at the selected resolution.

Layout Save/Load

The Save Scene/Layout and Load Scene/Layout buttons allow a video wall configuration to be
saved or recalled at any time. When saving, each Scene can optionally be given a name to identify

that video-wall scene setup.

Up to 10 configurations (pre-sets), each with their own name can be saved or recalled.
These Pre-set configurations can also be recalled using RS232 command.

sy.uk
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Daisy chain and Cascade mode
VWP24 / VWP29 support daisy chain and cascade modes, enabling large VW configurations (up
to 8x8).

To control the units, following R$232 connection can be used (For example, 3 VWP29 units
connection)

Qutputs 1~ 9 Qutputs 10~ 18 QOutputs 19~ 27
Device ID 1, Output Port Index 1 Device ID 2, Output Port Index 10 Device ID 3, Output Port Index 19
RS232-CTL RS232 RS232-CTL RS232 RS232-CTL RS232

| | f

PC / Laptop

To build daisy chain or cascade connection, user need separately configure each unit Device ID
and First output port index first by its own LAN or RS232-CTL port

The first unit device ID should be set 1, and its first output index should be set to 1
The second unit device ID should be set 2, and its first output index should be set 10 (if the first
unit is VWP29) or 5 (if the first unit is VWP24)

The third unit device ID should be set 3, and its first output index should be set 19 (if there are
total 18 output ports, 2x VWP29, before this unit) or 14 (if there are total 13 output ports, 1x
VWP29 and 1x VWP24 before this unit).

1. Set Device ID and First output index
Connect the PC tool with VWP24/VWP29, press Ctrl+Shift+F2 on the PC (some laptops may
also need the Fn key to use the function keys), and turn to video wall tab, user can set the
parameters in the Device Setting section located at the left lower corner:

Switch | Signal Setting | PQ&Position Video Wall | Network Setting | UART Setting |

— VideoWall Setting — Video Wall
Rows 3 )
Columns 3 &) Screen 1 Screen 2 Screen 3
Available 9 0
[ Set J[ Read |

Bezel Setting Screen 4 Screen b Screen b
Type: @A ©B

Left(Pixels) ]
Right(Pixels) I:l
Top(Pixels) l:l Screen 7 Screen 8 Screen 9
Botomeixels) | |

Layout Save/Load
’TSave Layout | Load Layout |

Device Setting
Device ID
First Output Index
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Following is the PC Tool status when a VWP29 and a VWP24 are connected together (the first
unit is the VWP29)
SY

Switch }s\gnal Setting | PQ&Position | Video Wall | Network Setting | UART Setting

OUTPUTS INEUT; LOOP OUT INEUT; AUDIO OUTPUT ANEBUT;
SHDA ®HDB SHDA ®HDB y SHDA ®HDB

HDMI 1 B/MAIN 1 Audio ( 1=1 —
HDMI 2 B/MAIN 2 2 Aud 2 A2 ——
HDMI 3
HDMI 4
HDMI 5
HDMI 6
HDMIL 7
HD
HDMI @
HDMI 10
HDMI 11

HDMI 12

HDMI 13

o] ® rort [ Status

There are total 13 scaling output ports, all these ports can be used for splicing.
There are two B/MAIN and two Audio output selections for unit 1 and unit 2.
With Daisy chain or cascade connection, user can get following video walls

LAN and RS232 Control Commands

All the ASCII commands given in this section use the following RS232 port settings:

Baud Rate: 57600
Data Bits: 8
Parity: None
Stop Bits: 1

All the ASCII RS232 commands given in this section can also be sent to the LAN port using the
following settings:

Default IP Address: 192.168.0.247
Default Network Mask: 255.255.255.0
Default Gateway: 192.168.0.1
Default TCP Port: 23 —Telnet

Notes:

1. All commands in this section are always terminated with the ASCII carriage-return
character, 0x0d. This is represented by the «' symbol in each command.

2. All responses are always terminated with the ASCIl carriage-return and line-feed
sequence (0x0d 0x0a).

3. All spaces shown in the command are required. Lowercase letters are used as value
placement indicators, the required value or identifier is given in the Details panel for
each command.
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Video Selections
The following commands are used to make video selections:

Command Details

Select Input x to Output y
Where:
SET INx VIDEO OUTy+ x is in the either 1 or 2 for inputs A or B
y is in the range 1 to 4 for VWP24 outputs, or
1to 9 for VWP29 outputs.
Select Input x to All Outputs
SET INx VIDEO ALIL+ Where:
x isin the either 1 or 2 for inputs A or B

Examples:
SET IN1 VIDEO OUT2+ OUT2 VIDEO INI1+
SET IN2 VIDEO ALI+ ALL VIDEO IN2¢

Preset Save and Recall
The following commands are used Save or Recall presets for the video configuration:

Command Details

Save the current video configuration to preset memory z
SET SYS ROUTE-MODE z+' Where:

z is in the range 1 to 10 for presets 1 to 10

Set the Video Wall to pre-set z
GET SYS ROUTE-MODE z+ Where:

z is in the range 1 to 10

Examples:
SET SYS ROUTE-MODE 3¢ SYS ROUTE MODE 3¢
GET SYS ROUTE-MODE 7« SYS ROUTE_MODE 7+

Test Pattern

The following commands are used to enable of disable the test pattern for each output:

Command Details \
Enable the test pattern for Output y
Where:
SET OUTy TSP ON~
4 y is in the range 1 to 4 for VWP24 outputs, or
1 to 9 for VWP29 outputs.
Disable the test pattern for Output y
Where:
SET OUTy TSP OFF+
Y y is in the range 1 to 4 for VWP24 outputs, or
1 to 9 for VWP29 outputs.
Read the test pattern setting for Output y
Where:
GET OUTy TSP+
4 y is in the range 1 to 4 for VWP24 outputs, or
1 to 9 for VWP29 outputs.
Examples:
SET OUT2 TSP ON+ OUT2 TSP ON¢
GET OUT5 TSP+ OUT5 TSP OFF+
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DAISY-CHAIN
MODE EXAMPLE

Unit 1 4x4 VIDEO WALL
VWP24-18G CONNECTION LAYOUT

HDMI

Sources 4 x HOMI

Unit2
VWP24-18G

HD1 HD2 HD3 HD4

4 x HDMI

HD1 HD2
HD3 HD4

4 x HOMI

Unit 4
VWP24-18G

4 x HDMI

POSSIBLE VIDEO WALL

IMAGE LAYOUT EXAMPLES
ax2 [/ 2x2 [ 2x2
Single Image Video Wall or 4x4 with single image inserts 2x2 in each quadrant
4x4 with 2 off 2x2 inserts

HDM| Sources

CASCADE MODE

EXAMPLE Unit 1 Axd VIDEQ WALL
CONMECTOIN LAYOUT

HDA HDB

HD1 HD2 HD3

BESalEil HD4 HD5 HD& HD7

Each display can show a single
imagefrom either source

Single Image Video Wall Axdwall with 2x2 wall inserted Axdwall with single image inserted

HDA HDB HD1 HD2 HD3 HD4 HD5 HD& HD7
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Specifications

General
HDMI Version
HDCP Compliance
RS232-CTL (Tx, Rx)
RS232 (Pass-Through — Tx, Rx)

Video and Audio

Input Video Formats
Supported

Output Scaled Resolutions

Audio Format Supported

Power Supply
Power Consumption

Supply Voltage

HDMI 2.0,18Gbps
HDCP 2.2 and HDCP 1.4

57600 baud, 8 data bits, 1 stop bit, no parity

Any baud rate to maximum of 115200.

4096x2160p 24/25/30/50/60Hz
3840x2160p 24/25/30/50/60Hz
1080p 24/25/30/50/60Hz

1080i 50/60Hz

1920x1200 60Hz

1680x1050 60Hz

1600x1200 60Hz

1440x900 60Hz

3840x2160p 60Hz
3840x2160p 50Hz
3840x2160p 30Hz
3840x2160p 25Hz
1920x1200 60Hz

1920x1080p 60Hz
1920x1080p 50Hz
1600x1200 60Hz

2.0 channel ,5.1 channel
LPCM, Dolby, AC3, DTS

VWP24-18G: 40W Max.
VWP29-18G: 70W Max.

110-240 VAC

Environmental and Physical

Operating Temperature Range

Operating Humidity Range

Dimensions (L x W x H)

Weight (Unit only)

V1.0

0 to +40°C (+32 to +104 °F)
10 to 90 % RH (non-condensing)

VWP24-18G: 218 x 146 x 43 mm
VWP29-18G: 430 x 220 x 44 mm

VWP24-18G: 2kg
VWP29-18G: Skg

15

1400x1050 60Hz
1366x768 60Hz
1360x768 60Hz
1280x1024 60Hz
1280x960 60Hz
1280x800 60Hz
1024x768 60Hz
1280x720p 50/60Hz

1440x1050 60Hz
1366x768 60Hz
1360x768 60Hz
1280x1024 60Hz
1280x768 60Hz
1280x720p 60Hz
1280x720p 50Hz
1024x768 60Hz

sy.uk
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Package Contents

Item

VWP24-18G or VWP29-18G unit

12V/3A adapter (VWP-24 only)

AC Power cord (IEC C13) — (VWP-29 only)
5 pin female captive screw connector

3 pin female captive screw connector

User Manual

PN R R R e

Safety Instructions
To ensure reliable operation of this product as well as protecting the safety of any person using
or handling these devices while powered, please observe the following instructions.

1.

Do not operate these products outside the specified temperature and humidity range
given in the above specifications.

Ensure that these products are adequately ventilated to allow them to operate
efficiently as these products do generate heat during normal operation.

Repair of the equipment should only be carried out by qualified professionals as these
products contain sensitive devices that may be damaged by any mistreatment.

Only use this product in a dry environment. Do not allow any liquids or harmful
chemicals to come into contact with this product.

After Sales Service

1.

sy.uk

Should you experience any problems while using this product, firstly refer to the
Troubleshooting section in this manual before contacting SY Technical Support.

When calling SY Technical Support, the following information should be provided:

e Product name and model number
e Product serial number
e Details of the fault and any conditions under which the fault occurs.

This product has a two years standard warranty, beginning from the date of purchase
as stated on the sales invoice. For full details please refer to our Terms and Conditions.

SY Product warranty is automatically void under any of the following conditions:

The product is already outside of its warranty period
Damage to the product due to incorrect usage or storage
Damage caused by unauthorised repairs

Damage caused by mistreatment of the product

Please direct any questions or problems you may have to your local dealer before
contacting SY Electronics.

16 V1.0


http://www.sy.co.uk/

